23

Process Explorer

by 
Julia Wilkerson
Jacob Belmore
Sarah Peters

Operating Systems and Networks
Operating Systems Team Project

November 23, 2010

Table of Contents

Program Background 






3
Download & Installation





4
Basic Reporting Functions 





4


Main Screen Overview 





4
Viewing Memory Information 




5
Viewing Networking Information 



6
Viewing CPU Information 




6
Viewing Input and Output Information 



7
Specific Process 




7
Overall 






9
Basic Administrative Functions 





11
Advanced Data Mining 






12


Run, Ready, Wait 





13
I/O MetaData 






14
            Dynamic Resource Tracking 




16



Process Explorer
Process Explorer is a system data reporting tool, originally developed by Sysinternals, Inc. and later purchased by Microsoft. Process Explorer reports data on each process, including data on which resources are being held, how and how much real and virtual memory is being used and allocated, priority and amount of CPU Time a process has taken, as well as other functions. Process Explorer also contains tools for managing processes, allowing the user to edit security privileges, killing processes as well as entire trees, and allowing the user to suspend active processes. 
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Process Explorer is freeware, available from the Microsoft Website as well as a number of other sites. The version used in this presentation is version 14.0, downloaded from the Microsoft Technet Website on November 21, 2010.


Download & Installation
1. Navigate to the website (http

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"://

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"technet

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA".

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"microsoft

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA".

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"com

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"/

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"en

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"-

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"us

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"/

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"sysinternals

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"/

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"bb

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"896653.

HYPERLINK "http://www.google.com/url?q=http%3A%2F%2Ftechnet.microsoft.com%2Fen-us%2Fsysinternals%2Fbb896653.aspx&sa=D&sntz=1&usg=AFQjCNHuMN3V7rU8y0l2GAnNFAdB8xFFXA"aspx) 

2. Click on the blue text that reads Download Process Explorer. 

3. Follow the on-screen instructions to download the .zip file.

4. Navigate to the folder on your computer where you saved the .zip file. 

5. Right click on the file 

6. Select the Extract All option to open the .zip file.

a. If you do not have an Extract All option, Google for instructions to open .zip files on your operating system.

7. Move the new folder created in the directory where the .zip file was opened to where you wish to store the program.

8. The program is now installed.

Basic Reporting Functions
Main Screen Color Coding


The main screen has an important customization feature, allowing you to choose and better understand the color coding options available that describe the status and type of the various processes currently running. The information is accessed by navigating to the Options menu and selecting the Configure Highlighting menu item
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There are several defaults already set, including the following:
· Green for new objects
· Red for deleted objects
· Pale purple for the current user’s processes
· Pale red for service processes run by the operating system
· Purple for packed images
· Dark orange for jobs
· Yellow is shared by both .NET processes and relocated Dynamic Link Libraries.
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Viewing Memory Information
Process Explorer offers a variety of ways to locate information about how memory is being used. One option is to view memory information for the entire system. To do this, click the View menu at the top of the Process Explorer window, and select the “View System Information” option. In the System Information window that appears, select the ‘Memory’ tab. On this screen you will find a summary of your system’s memory information, including information about how much physical memory is in use, how much memory exists in pages, how much memory (both virtual and real) is being used outside of pages, how many page faults are occurring across your system, and paging list information.
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For viewing process-specific memory information, double-click the process you want to view from the main Process Explorer Window. In the window that pops up, select the ‘Performance’ tab. On this screen, you can see information about how much memory is being used by a process. Under the ‘Virtual Memory’ header, you can see how much disk space is being taken up by this process, the number of private bytes, the number of page faults the process has encountered, and a rough estimate of the rate of page faults the process is encountering. Additionally, under the ‘Physical Memory’ header, information is displayed on memory priority (on a scale of 1-8), as well as information about the working set.
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Viewing Networking Information
 Another element of Operating System Functionality that is included in Process Explorer is the ability to monitor which ports are in use by which programs. To view this information, select and double-click a process you wish to view from the main Process Explore Window. In the process properties window, select the TCP/IP tab. From this view, you can see how many connections the process is maintaining, as well as specific information about those connections, such as which protocol is being used to manage that connection, the local address and remote addresses of the two nodes, and what state the connection is in. Additionally, in some versions of Windows, you can view the connection stack by double clicking on the connection within the window.
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Viewing CPU Information
Another aspect of system information that can be observed with Process Explorer is information about the load of different tasks and processes on the CPU. Like Memory information, CPU reporting can be done in both system-wide and process-specific contexts. Viewing information about the CPU load on the entire system can be done by clicking on the ‘System Information’ button at the top of the main Process Explorer window. Once in the System Information screen, clicking on the ‘CPU’ tab reveals an abundance of information about the CPU, including the number of active handles, threads, and processes. Additionally, predictive information is available for the number of Context changes, Interrupts, and Deferred Procedure Calls is shown here.
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Viewing information about specific processes can be done by double-clicking on the process in the main Process Explorer window, and selecting the ‘Performance’ tab in the process Properties window. Looking under the CPU header will reveal the process priority, as well as the amount of time (in milliseconds) the process has spent within the Kernel, in interface with the user, and the number of CPU Cycles the process has gone through. 
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Additionally, by clicking on the ‘Threads’ tab in the Process Properties window, you can view specific information on each part of the process, including thread IDs, thread start times, specific processor time for each thread, the current CPU state (run, ready, or wait), the number of context changes the thread has gone through, and the number of cycles it has been active. as well as being able to sift through the stacks associated with each thread.
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Viewing Input and Output Information

Specific Processes

In order to view Input/Output (I/O) information you must select a specific process to view the information for. This is done by right clicking the process to gather information on in the main view window, and selecting the Properties option.
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Selecting the Performance tab in the new window, you are able to view the I/O information. From this screen you can determine the basic I/O statistics of a process. This includes things like the process’ priority for I/O use, the number of reads and writes, as well as the number of writes or reads, and the amount of data written or read in a dynamic unit measure. The units will change between byte, kilobyte and other reasonable units as required. It will also give the same information of ‘other’ I/O usage.
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Overall

To access the overall I/O information, you simply click on any of the graphs in the main screen, to bring up a detailed window of system information.
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Once this window is up, access the I/O tab to view the graph and detailed I/O information for the system as a whole. The information provided consists of data on current read, write and ‘other’ units, followed by the amount of bytes operated on, in units of kilobytes.
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Basic Administrative Functions
In addition to the reporting functionality included in Process Explorer, users can use the program to manage their processes as well. By selecting a process in the main Process Explorer and clicking on the ‘Process’ menu, there are several options for managing the processes, including options to bring the process’ main window to the front, Kill, Suspend, and Restart. Additional functionality to change the priority of the process and to create dumps of the process information are available.
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Another unique ability of Process Explorer is the ability to associate a specific task with a single processor in a multi-core system. To do this, select the process you wish to link from the main Process Explorer window, and select the ‘Set Affinity’ option from the Process menu. Select which CPUs should handle that process from the window that appears, and click OK to link that process to that CPU(s).

Advanced Data Mining

Process Explorer can be used to discover additional information about processes, such as the amount of time spent in the run state, compared to the ready and wait ratio, estimates of how much data is being transferred during I/O, and specified resource lists for each process.

Run, Ready, Wait

Process Explorer allows the user to determine how much time a task spends in each of the Run and Wait states. To find this information, open the process properties view, and select the threads tab. Each process is made of one or more threads, and this view presents information about how much time each thread spends within the CPU Kernel, how much time is spent waiting for user input (for I/O,) and the amount of time spent since the thread began.
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By examining this data closely, we are able to determine how much time the thread spent in each of these states. Summing the Kernel Time and User Time statistics creates the amount of time spent in the Run state, and subtracting that from the amount of time the thread has been running (which can be determined from the thread start time on the same page,) will allow the user to derive the time spent in the wait state.

Process Explorer is effective for  determine this information about  processes which only consist of a single thread (such as Microsoft’s NotePad,) but given the nature of  many modern  computer programs, which run multiple simultaneous threads, it can be difficult to determine how  much time these programs spend in  each state, as each thread would need to be monitored independently and then the totals summed after the task terminated. 


I/O MetaData (data about data)
Another advanced dataset that Process Explorer gives access to is information about how much Data is being transferred during I/O. To access this information, select the performance tab from the process properties window.

[image: image16.png]Searity

Environment

TCPIP.
inese || Feromance

Performance Graph

U
priority s
Kernel Tme 0:00:10.218
User Time 0:01:34.708
TotalTime. 0:01:44.926
Cydes 425,082,594,465
Virtual Memory

Private Bytes 79,700K
PeskPrvateBytes  89,112K
Virtual Size: 352,864K
Page Faults 587,835
Page Fault Delta 3

Physical Memory.

Memory Priority H

Working Set 9,963K
s Private 25,400K
WsSharesble  21,568K
Vis Shared EE

PeskWorkngSet 59,086 K

10

1o priority
Reads

Read Delta

Read Bytes Delts
Virites

Viite Delta

Wite Bytes Delta
Other

Other Delta
Other Bytes Delta
Handies

Handies

DI Handies
USER Handles





From this screen, you can view how much data is being transferred at any given moment in I/O (The Read Bytes Delta Column). In addition, you can see the total number of Reads, Writes, and Other I/O functions (such as page faults.)

Additionally, running Process Explorer in Windows 7 allows the user to view additional data about how much Disk and Network I/O is being done. By clicking on the Disk and Network tab in the process properties window, you can see the number of network and disk reads and writes, respectively.

Alongside the process-specific I/O information, this data is available for system-wide I/O as well. To view this data for the entire system, select the ‘System Information’ button from the main Process Explorer window, and click on the I/O tab. As with process specific data, extra information is available in Windows 7 about disk and network I/O.

Dynamic Resource Tracking

Another really cool feature of Process Explorer is the ability to show which processes and threads are locking down which dynamic resources. These consist of Dynamic Linked Lists (.dll files) and Database files (.db files). To view this data, select the ‘Show Lower Pane’ option from the View menu at the main Process Explorer window. Next, return to the view menu, and select ‘Dlls’ from the Lower Pane sub-menu.
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By tracking which processes use which data libraries, you can gain some useful insight into which libraries are the most commonly used, as well as seeing potential system lag issues due to competition over common resources. Lastly, this information could be useful in advanced systems, such as those which use SSDs for storing system files.
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